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Writing Your First Firmware for PDS-700

WARRANTY

All products manufactured by ICP DAS are warranted against defective materials for a period of one
year from the date of delivery to the original purchaser.

WARNING

ICP DAS assumes no liability for damages consequent to the use of this product. ICP DAS reserves
the right to change this manual at any time without notice. The information furnished by ICP DAS is
believed to be accurate and reliable. However, no responsibility is assumed by ICP DAS for its use,
nor for any infringements of patents or other rights of third parties resulting from its use.

COPYRIGHT

Copyright © 2018 by ICP DAS. All rights are reserved.

TRADEMARKS

Names are used for identification purposes only and may be registered trademarks of their
respective companies.

CONTACT US

If you have any questions, please feel free to contact us. We will respond within 2 working days.
Email: service@icpdas.com ; service.icpdas@gmail.com
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Writing Your First Firmware for PDS-700

1 Compiler and Linker for c Programming

To develop programs for PDS-700 series, you can use the 16-bit compilers below:

» Turbo C++ Version 1.01

» Turbo C Version 2.01

» Borland C++ Versions 3.1-5.2.x
» MSC

» MSVC ++

From Borland’s web site, you can download the free TC 2.01 compilers.
Web site: http://edn.embarcadero.com/article/20841
To download this, you must have registered as a free member.

Tips & Warnings

c Windows 7, Windows 10, or others 64-bit Windows do not support 16-bit

programs, 16-bit processes, or 16-bit components.

You can use the DOSBox emulator (http://www.dosbox.com) to emulate a

16-bit environment for running 16-bit compilers on 64-bit Windows.

There are two commonly used 16-bit C/C++ compilers: Turbo C++3.0 and Borland C++ 3.1. The
example below demonstrates how to run the Borland C++ 3.1 project on 64-bit Windows.
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Writing Your First Firmware for PDS-700

2 Configuring Boot Mode

Make sure the switch placed in the “Init” position.

H Init Mode

H Normal Mode

3 Connecting to PC and Power

To connect to the PC using a COM1 (RS-232) connection, please follow the instructions below.

1. Power off the PDS-700.
2. Connect the DB-9 connector of CA-0910 download cable to COM
Port (e.g., COM1) of your PC.
3. Wire the CA-0910 to PDS-700, as follows:
Connect the CA-0910.TX with PDS-700.TxD1
Connect the CA-0910.RX with PDS-700.RxD1
Connect the CA-0910.GND with PDS-700.GND
4. Power on the PDS-700.

com1

Power Supply
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Writing Your First Firmware for PDS-700

“Hello World” - Your Fist Program

Before writing your first program, ensure that you have the necessary C/C++ compiler and the
corresponding functions library on your system. Here, using the Borland C++ 3.1 on 64-bit Windows
is shown as an example.

Step 1

Get the DOSBox and install it on your computer

The latest version of the DOSBox can be obtained from SourceForge web site.

http://www.dosbox.com

After the installation has been completed, there will be a new short-cut for DOSBox on the desktop.

Step 2
Run the DOSBox

Open the DOSBox application from the icon located on the desktop.
DOSBox will display two windows, one is the DOSBox Status Window (shows the processes in the

"background") and another one is the main emulator window, which shows the emulated version of
DOS.

0SBox Status Window

0SBox version B.74
Copyright 2882-20180 D0SBox Team. published under GHU GPL.

CONFIG:Loading primary settings from config file C:“Documents and Settings“Mindo|
ws“\Local Settings™Application Data“DOSBox™doshox—8.74.conf
MIDI : Opened device:win3d2

SBox 0.74, Cpu speed: 3000 cycles, Frameskip 0, Program: DOSBOX

Welcome to DOSHox w@.74

For a short introduction for wew users type: INTRD
For supported shell commands type: HELP

To ad just the emulated CPU speed, use ctrl-F11 and ctrl-Fi2.

To activate the keymapper ctrl-F1.
For more information read the README file in the DOSBox directory.

HAVE FUN?
The DOSBox Team http:rwnas.dosbox.com

Z:~>SET BLASTER=AZZ20 17 D1 HS T6

ZiINY_
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Writing Your First Firmware for PDS-700

Tips & Warnings —
p g [ % FRun as administrato: J
. . . Fin to Taskbar k
If you're running Windows 7 or later OS, we would suggest SLEE
you to run the DOSBox emulator with administrator et o %
privileges. Right-click the icon or shortcut, and then click o
“Run as administrator”. Copy
Delete

Open file location

Properties

Step 3

Mount the drive as a virtual drive

For example, if you want to mount a drive D as a virtual drive D. At the command prompt (e.g., Z:\>)
of the main emulator window, type “mount d d:\” and then press <Enter>. (“d:\” part represents
the drive on your computer that you want to mount).

ton DOSBox 074, Cpu speed: 3000 cycles, Frameskip 0, Program: DOSBOX

Z:xcmount d od:s
Drive D is mounted as local directory d:\

2N

Step 4
Shift to drive D

At the command prompt (e.g., Z:\>) of the main emulator window, type “d:” and then press
<Enter>.

D8Box 0.74, Cpn speed: 3000 cycles, Frameskip 0, Frogram: DOSBOX

Zisemount d d:s
Drive D is mounted as local directory d:s

i

D:is>_
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Step 5
Add the Borland C++ compiler executable to the DOSBox path

For example, we assume that you use the Borland C++ 3.1 compiler, and its bin directory is in
“D:\BC31\Bin”. At the command prompt (e.g., D:\>) of the main emulator window, type “path
d:\bc31\bin” and then press <Enter>.

ton DOSBox 074, Cpu speed: 3000 cycles, Frameskip 0, Frogram: DOSBOX

Zinomount d od:s
Drive D is mounted as local directory d:s\

Zinod:
D:s>path d:xbc31sbin

D:v>

Step 6

Execute bc.exe to run the Borland C++ 3.1 IDE

At the command prompt (e.g., D:\>) of the main emulator window, type “bc” and then press
<Enter>.

toi DOSBox 0.74, Cpu speed: 2000 cycles, Frameskip 0, Program: DOSBOXE

Zisemount d d:s
Drive D is mounted as local directory d:s

Lined:

D:s>path d:5bc31sbin

D:\>ho

Step 7
Edit the source code and then save it

We provide many demo programs and library file that can be obtained from ICP DAS FTP site or ICP
DAS web site. The download addresses are shown below:
http://ftp.icpdas.com/pub/cd/8000cd/napdos/pds/pds-700/demo/
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Writing Your First Firmware for PDS-700

1. Here, the “hello” demo is used as an example. First download the “HELLO.C” and “7186EL.LIB”
files to the drive D, the “HELLO.C” and “7186EL.LIB” files is located at:
http://ftp.icpdas.com/pub/cd/8000cd/napdos/pds/pds-700/demo/firmware/basic/bc_tc/

2. Select “Open” from the “File” menu to open the “HELLO.C” file.

E DOSBox 0.74, Cpu speed: max 100% cycles, Frameskip 0, Program:  TC - K
JEiIE) Edit Search Run Compile Debug Project Options Window Help

Save all

Change dir...
Print
DOS shell

Replace 1

F1 Help | Locate an

|

F1 Help | Type for incremental search: lower for files, upper for directories

3. Modify the source code to print “Hello World” and save it.

#include <stdlib.h>
#include “7186e.h” /* include the necessary head file */
void main(void) {
InitLib(); /* initiate the 7186el.lib library*/
Print(“Hello world\n”); /* print the message on the screen */
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BH DOSBox 0.74, Cpu speed: max 100% cycles, Frameskip 0, Program:  TC - x

= File Edit 3Search Run Compile Debug Project Options Window Help
= HELLOSHELLO_CNHELLO.( ————

void main(woid)
{

InitLib():

Print(

B DOSBox 0.74, Cpu speed: max 100% cycles, Frameskip 0, Program:  TC — X

JEilE) Edit Search Run Compile Debug Froject Options Window Help

HELLONHELLO_CNHELLO.C

Save all

Change dir...
Frint
DOS shell

F1 Help FZ Sawve F3 Open nAlt-FS

Quit

TipS & Warnings Save the file in the active Edit window

You can write the code as shown below with your familiar text editor or other tools;
please note that you must save the source code under a filename that terminates with
the extension “C”.

Step 8
Create a project file (*.prj) and save it

1. Select “Open Project...” from the “Project” menu to create a project file (e.g., HELLO.PRJ).

B DOSBox 0.74, Cpu speed: max 1009% cycles, Frameskip 0, Program:  TC - Ed
= File Edit Search Run Compile Debug JEFGjEEtl Options

Window Help

Delete item
woid main(woid) Local options. ..
i Include files...
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Note that a “HELLO.PRJ” file has been built in this demo program. You can open this file to view it.

B DOsBox 0.74, Cpu speed: max 100% cycles, Frameskip 0, Program:  TC - x

= File Edit Search Run Compile Debug PFProject Options Window Help
= HELLOSHELLO_CNHELLD.C ———————

pen Project File

C:NHELLONHELLD_Ch, PRJ

void main(wvoid)

i
HELLO .PRJ
InitLib();

Print(

F1 Help | Type for incremental search: lower for files, upper for directories

If you don’t have a project file, please type “HELLO.PRJ” in the “Open Project File” field and press

<Enter> to create it.

B DOSBox 0.74, Cpu speed: max 100% cycles, Frameskip 0, Program:  TC - *

= File Edit Search Run Compile Debug Project Options Window Help
— Hlll.0 ——————————————

HELLO.PRJ
woid main(void)

{ iles
L™

InitLib():

Print(

F1 Help [ Enter directory path and file-name mask
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2. Add all necessary files (“*.C” and “*.lib”) to the project.

Note that in the demo program, the “HELLO.C” and “7186EL.LIB” files have been added to the
project (e.g., HELLO.PRJ), as shown below.

B DOsSBox 0.74, Cpu speed: max 100% cycles, Frameskip 0, Program:  TC — *

= File Edit Search Run Compile Debug Project Options Window Help
HELLOMHELLO_CSHELLO.C

wvoid main(uoid)
i

InitLib():

Print(

HELLO.C

F1 Help Ins Add Del Delete “0 Options Space Includes 4— Edit F10 Menu

If you don’t have added these files (“*.c” and “*.lib”), please follow the steps below.
i. Select “Add item...” from the “Project” menu.
ii. Choose the “HELLO.C” and “7186EL.LIB” files and click on the “Add” button.

» 0, Program: TC —
g WEEGlEst] Options

Open project...
Close project

Cpu speed: max 100% cycles, Frameskip 0, Program:  TC - it
File Edit 3Search Run Compile Debugy Froject Options Window Hel

Include fil

ane
C:\LIB\?186EL.LIB |

iles
7186EL.LIB

fidd file to project items
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Step 9

Specify the Include and Library directories where the compiler can
search for header file and libraries

Click on “Options” and select “Directories...” to enter the BC++ 3.1 include and library directories.

By default, the directories are same as the installation directory of the BC++ 3.1 compiler.

B DOSBox 0.74, Cpu speed: max 100% cycles, Frameskip 0, Program:  TC — ¥

File Edit Search Run Compile Debug Project Jiptionsll Window Help
- HELLO.C

Application. ..
Compiler 2
Transfer...

Make. ..

Linker »
woid main(woid) Librarian. ..

{ Thm b werrrrman

L1505 ( o Ere—|

BH DOSBox 0.74, Cpu speed: max 100% cycles, Frameskip 0, Program:  TC — »
= File Edit Search Bun Compile Debug Project Options Window Help
1

nclude Directories

0 D :~\BC31~INCLUDE

D:~\BC31:\LIE

utput Directory

output files

ource Directories

F1 Help | The directories to search for your library (.LIB) files
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Step 10

Select “Build all” from the “Compile” menu to build the project

e
lp

E DOSBox 0.74, Cpu speed: max 100% cycles, Frameskip 0, Program:  TC

= File Edit Search Run [JEGRMPANEN Debug Ploject Options Window He

woid main(woid) E DOSBox 0.74, Cpu speed: max 100% cycles, Frameskip 0, Program:  TC — b4

i

File Edit 3Search BRun Compile Debug PFProject Options Window Help

InitLib():

Print(

EXE file : HELLD.EXE
void main(uoid) Linking : SNTCSLIBSCL.LIB
{

InitLib(); Total Link
Print ( Lines compiled: 1822 PnAss 2
Warnings: © Q
Errors: O Q

Rebuild all |[CEFEEERg W JES

fivailable memory:

F1 Help nlt-F8 Mext Msg Alt-F? Prev Msgy nAlt-F9 Compile F9 Make F10 Menu

Tips & Warnings

More C/C++ compiler settings, please refer to
http://ftp.icpdas.com/pub/cd/8000cd/napdos/minios7/document/compiler v1.1.pdf
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5 Uploading and Executing

» ThisPC » Windows (D:) » Hello » Hello_C

~

!

Mame

[h] 7186e.h
| 7186EL.LIB
ERENET
| HELLO.BAK
[6] HELLO.C
‘| HELLO.DSK
[5] HELLO.EXE
| HELLO.PRJ

N TN

NN

Download files to the PDS-700 using the 7188xw.exe, refer
to the following instruction.

1. The 7188xw.exe is copied to the directory where the
“HELLO.exe” file is located (e.g., D:\Hello\Hello_c\), and
confirm that the PDS-700 is connected to the Host PC (refer
to Chapter 3 “Connecting to PC and Power”).

2. Open command prompt in Windows and change the current directory to the directory where the

“HELLO.exe” file is located.

. CAWINDOWS\system 32 wmd exe

C:=~Documents and Settings“Jammy>D:

D:~>cd Hello

D:“Hello>cd HELLO_C

D:“Hello~Hello_C>_

3. Type “7188xw /c1 /b115200” and press <Enter> to execute the 7188xw.exe and then press
<Enter> again to connect to the PDS-700, which will show “PDS-700>".

v T188X'W 1.36 [COM1:115200,N,8,1],FC=0,CT5=0, DIR=D:'Hello\Hello_C

D:“Hello“Hello_G>7188xw ~sci ~b115208

[7188x for WIN32 version 1.36 (2088-/82-263[By ICPF DAS. Tim Tsai.l
[Begin Key Thread...1Current set: Use COM1 115206, H.8.1

AutoRun:
Autodownload files: cr CR

Current work directory=""D:“Hello~Hello_C"' “"f’\\‘v}

Tips & Warnings >
Q The “c1” depend on your PC COM 2
Port that connects to PDS-700. 5

~

“‘v""‘*\,ﬂf’"\wﬁm—r’\/
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4. Press <F2> and type the filename “HELLO.exe” and then press <Enter>.

7188XW 1.36 [COM1:115200,K,8,11,FC=0,CTS=0, DIR=D:\Hello\Hello_C

D:“Hello“Hello C>718Bxw ~c1 ~#hl115288

7188 for WIN32 version 1.36 (2808/82-/26>[By ICP DAS. Tim Tsai.]
[Begin Key Thread...1Current set: Use COM1 1152060.H.8.1

AutoRun:

Autodownload files: cr CR

Current work directory=""D:“Hello“Hello_C"

PDS—700 >
Input filename :HELLO.ERE
W'hen Press FBAF?-F18 will auto download the file:HELLO.EXE

5. Press <F9> to upload the “HELLO.exe” file.

7188X W 1.36 [COM1:115200,H,8,1],FC=0,CT5=0, DIR=D:\Hello\Hello_C

D:*Hello“Hello _C>7188xw ~/c1 ~bh115208

7188x for WIN32 version 1.36 {2808-82-26>[By ICP DAS. Tim Tsai.l
[Begin Key Thread...lCurrent set: Use COM1 115208.H.8.1

AutoRun:

Autodownload files: cr CR

Current work directory=""D:“Hello*Hello C"

PDE-780 >

Input filename:HELLO.EXE

Wlhen Press FB8-/F?-F18 will auto downleoad the file:HELLO.EXE
[F? 1LOAD

File will save to 78BE:000B
StartAddr—— >9800 :8BBEA

Press ALT_E to download filet

Load file:HELLO.EXElcrc=B?71 . 00001
Send file info. total 64 hlocks
Block 64

Tranzsfer time is: 2.625000 zeconds

PDS-788>

6. Type “HELLO.exe” and press <Enter> to execute it.

T188XW 1.36 [COM1:115200,N,8,11,FC0,CT30, DIR=D:\HelloAHello_C

PDS—788>hello -exe
Hello world

PDS-7088>
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6 Related Information

-

e PDS-700 Document:
http://ftp.icpdas.com/pub/cd/8000cd/napdos/pds/pds-700/document/

e PDS-700 Firmware:
http://ftp.icpdas.com/pub/cd/8000cd/napdos/pds/pds-700/vxcomm/server(pds)/

 Demos and Library:

http://ftp.icpdas.com/pub/cd/8000cd/napdos/pds/pds-700/demo/
http://ftp.icpdas.com/pub/cd/8000cd/napdos/7186e/demo/

e More C/C++ Compiler Settings:

http://ftp.icpdas.com/pub/cd/8000cd/napdos/minios7/document/compiler v1.1.pdf

.
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